Optimizing PCC EHR: Workflow & Configuration Improvements You Can Use Today

Jim Leahy
Physician’s Computer Company
Goals of this Course

- PCC EHR changes constantly and we are always adding new and exciting features that can help optimize your use of PCC EHR.
- This course will focus on some of the new PCC EHR functionality, providing you with takeaways that you can begin using at your practice.
Managing Patients/Accounts
Add Patients/Accounts in PCC EHR

- It is possible to add patients, add accounts and reassign accounts in PCC EHR!
- The Assign Account option is available in the patient demographic section
- The Add Patient or Add Account option is only visible after you have performed a search for a patient or account
Add Patient
Add Patient
Add Patient

<table>
<thead>
<tr>
<th>Demographics</th>
<th>Han Solo Jr 28 years</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Patient Demographics</strong></td>
<td></td>
</tr>
<tr>
<td>Han Solo Jr</td>
<td></td>
</tr>
<tr>
<td>Date of Birth:</td>
<td>05/16/89</td>
</tr>
<tr>
<td>Sex:</td>
<td>Male</td>
</tr>
<tr>
<td><strong>Birth History</strong></td>
<td></td>
</tr>
<tr>
<td>GA at Birth:</td>
<td>Undetermined</td>
</tr>
<tr>
<td>Multiple Birth:</td>
<td>Undetermined</td>
</tr>
<tr>
<td><strong>Race, Ethnicity, and Preferred Language</strong></td>
<td></td>
</tr>
<tr>
<td>Race:</td>
<td></td>
</tr>
<tr>
<td>Ethnicity:</td>
<td></td>
</tr>
<tr>
<td>Pref. Language:</td>
<td></td>
</tr>
<tr>
<td><strong>Patient Information</strong></td>
<td></td>
</tr>
<tr>
<td>Patient Flags:</td>
<td></td>
</tr>
<tr>
<td>PCP:</td>
<td></td>
</tr>
<tr>
<td>SSN:</td>
<td></td>
</tr>
<tr>
<td>School:</td>
<td></td>
</tr>
<tr>
<td>Alt. Name:</td>
<td></td>
</tr>
<tr>
<td>Chart #:</td>
<td></td>
</tr>
<tr>
<td>Relation to Bill Payor:</td>
<td></td>
</tr>
<tr>
<td><strong>Communication Preferences</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Patient’s Confidential Communication Preference</strong></td>
<td>No Preference</td>
</tr>
<tr>
<td><strong>Account Demographics</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Home and Billing Account</strong></td>
<td>Fred Flintstone (Account # 1980)</td>
</tr>
</tbody>
</table>
| **Address** | 1400 Rock Road
Winnooski, VT 05404 |
| **Phone** |  |
| Primary: | 802-555-0105 |
| Secondary: | 802-555-0146 |
| Text Phone: | 802-555-0112 |
| Emerg Phone: |  |
| **Account Information** |  |
| Account Flags: | Billing Problem |
| EMG Contact: | Wilma |
| EMG Phone #: | 802-991-9911 |
| Alt Last Name: |  |
| Mother SSN: | 134-334-8932 |
| Father SSN: | 567-127-4815 |
| Pharmacy #: |  |
| **Recent Financial History** |  |
| Last Service: | 12/22/16 |
| Last Bill Sent: | 04/23/17 |
Reassign Patient Account(s)
Add New Account
Add New Account

Create Account
- First Name: Denise
- Last Name: Hamann
- Address: 12345 Main Street
- Address 2: Burlington, VT, 05401
- Phone: Primary: 802-340-2039

Account Information
- Account Flags:
- EMG Contact:
- EMG Phone #:
- Alt Last Name:
- Mother SSN:
- Father SSN:
- Pharmacy #:

Recent Financial History
- Last Service:
- Last Bill Sent:
- Last Pers. Pmt:
- Last Ins. Pmt:
- Hold Bill Until:
- Budget Amt: $
Reassign Account Options

Selected account:
Denise Hamann (Account # 4014)

Assign as:
- Home Account
- Billing Account
- Home and Billing (Current Account: Elaine B. Hamann (Account # 1612))
Policies in PCC EHR

- Users can edit, add, and expire policies in PCC EHR.

<table>
<thead>
<tr>
<th>Policies</th>
<th>Insurance</th>
<th>Copay</th>
<th>Certificate</th>
<th>Group</th>
<th>Start</th>
<th>End</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Aetna HDHP</td>
<td>$15.00</td>
<td>34DFJH</td>
<td></td>
<td></td>
<td>10/13/15</td>
<td></td>
<td>Active</td>
</tr>
<tr>
<td>2. Medicaid</td>
<td>$0.00</td>
<td>123456789</td>
<td></td>
<td></td>
<td>06/18/18</td>
<td></td>
<td>Active</td>
</tr>
</tbody>
</table>
Policies in PCC EHR

- All active plans from Partner are searchable
- Can auto-fill last modified or sibling’s policy info
Policies in PCC EHR

- Medicaid plans are denoted with an “M”
- These plans auto-fill patient info in subscriber section
Personal Contacts

- Personal Contacts is EHR-only
- Additional contacts (including additional parents) for the patient can be added with contact information and notes.

<table>
<thead>
<tr>
<th>Personal Contacts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Contacts have not been entered.</td>
</tr>
</tbody>
</table>

Select a personal contact

Add Patient Contact
Kevin Setlock (Custodian)

<table>
<thead>
<tr>
<th>Primary Insurance</th>
<th>Secondary Insurance</th>
</tr>
</thead>
</table>
Personal Contacts

Karen Setlock (Maternal Grandmother)
Phone: 240-304-3049

Note: Watches Carrie after school. Can bring in for appts and call with questions.
Copy Notes to Siblings

- The following components on the medical summary can be copied between siblings:
  - Medical History, Social History, Family Medical History, Reminders
- There are two options to access the option to copy notes:
  - Click Edit > Copy Notes to Siblings
  - Right-click on the component you want to copy
Copy Notes to Siblings
Copy Notes to Siblings

<table>
<thead>
<tr>
<th>Condition</th>
<th>Relationship</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eczema</td>
<td>Brother</td>
<td></td>
</tr>
<tr>
<td>Anemia</td>
<td>Maternal A</td>
<td>Copy Family Medical History to Siblings</td>
</tr>
<tr>
<td>Epilepsy</td>
<td>Maternal Uncle, Mother</td>
<td></td>
</tr>
</tbody>
</table>
Copy Notes to Siblings

**From:** Train Pebbles Flintstone  10 yrs, 1 mo  5/15/06  F

<table>
<thead>
<tr>
<th>Condition</th>
<th>Relationship</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eczema</td>
<td>Brother</td>
</tr>
<tr>
<td>Anemia</td>
<td>Maternal Aunt, Paternal Grandmother</td>
</tr>
<tr>
<td>Epilepsy</td>
<td>Maternal Uncle, Mother</td>
</tr>
</tbody>
</table>

**To:** Train Dino Flintstone  4 yrs, 2 mos  3/24/12  M

- Append
- Replace
- Custom
- Do Not Copy Notes for this Patient

<table>
<thead>
<tr>
<th>Condition</th>
<th>Relationship</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eczema</td>
<td>Brother</td>
</tr>
<tr>
<td>Anemia</td>
<td>Maternal Aunt, Paternal Grandmother</td>
</tr>
<tr>
<td>Epilepsy</td>
<td>Maternal Uncle, Mother</td>
</tr>
</tbody>
</table>
Working with Documents
Documents in PCC EHR

- Possible to create a task from the Import Documents screen
- Tasks visible on Messaging queue and in patient’s chart
- If a document has been set to require a provider’s signature, the document can now be signed from anywhere the document is viewed
Create Task in Import Documents
### Document Task in Messaging Queue

<table>
<thead>
<tr>
<th>Date</th>
<th>Patient</th>
<th>Subject</th>
<th>Task</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/09/17 11:51am</td>
<td>Flintstone, Pebbles</td>
<td>Document - Lab result</td>
<td>FYI</td>
<td>Elizabeth Casey, M.D.</td>
</tr>
<tr>
<td>06/07/17 7:53pm</td>
<td>Flintstone, Pebbles</td>
<td>Document - radiology</td>
<td>Call Parent with Result</td>
<td>Joan Abbott, NP</td>
</tr>
</tbody>
</table>
Viewing Document Task

- **Task:** FYI
  - **To:** Elizabeth Casey, M.D.
  - **Note:** Patient should be called with results.
- **Task Completed**
  - **By:** Elizabeth Casey, M.D.
  - **At:** 06/09/17 11:53am

- **Task:** Call Patient with Result
  - **To:** Alice Normand
  - **Note:**
  - **Task Completed**
    - **By:** select a user
    - **At:** 12:00am
Patient Demographics Included

<table>
<thead>
<tr>
<th>Task: Call Patient with Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>To: Alice Normand</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>Task Completed:</td>
</tr>
<tr>
<td>By: select a user</td>
</tr>
<tr>
<td>At: 12:00am</td>
</tr>
</tbody>
</table>

**Communication Preferences**

**Home and Billing Account**
Wilma & Fred Flintstone-Smith (Account # 1981)

**Address**
15 Quarry Lane
Colchester, VT 05446

**Phone**
- Primary: 802-655-1234
- Secondary: 802-555-0197
- Text Phone: 802-555-0161
- Emg Phone: 802-555-0168
Task Visible in Documents Screen

Documents

- Correspondence/Consults (1)
- Demographics (1)
- General (1)
- Hospital (1)
- Insurance/Billing (1)
- Lab (1)

Title: Lab result
Category: Lab
Attached to: 05/11/17 - Sick - Bright Futures
Lab - Influenza A/B

- Tasks: 2 (1 Completed)
  - Task: FYI
    - To: Elizabeth Casey, M.D.
    - Note: Patient should be called with results. [pcc 06/09/17 11:53am]
    - COMPLETED [elizabeth]
  - Task: Call Patient with Result
    - To: Alice Normand

Last Modified: pcc 06/09/17 11:54am
Edit/Sign Document

Title: Lab result
Date: 05/11/17
Category: Lab
Pages: 1

Attached to: 05/11/17 - Sick - Bright Futures
Lab - Influenza A/B

Tasks: 2 (1 Completed)

- Task: FYI
  To: Elizabeth Casey, M.D.
  Note: Patient should be called with results. [pcc 06/09/17 11:53am]
  COMPLETED [elizabeth]

- Task: Call Patient with Result
  To: Alice Nomand

Communication Preferences
Account Demographics

Last Modified: pcc 06/09/17 11:54am
Keep Documents Open as You Chart

Placing windows side-by-side allows you to easily copy data from an imported document into the patient’s chart.
Show Documents in the Patient Portal

- When importing a document to a patient’s chart you can choose to show the document in the patient portal
- Fill out the Title note box so that the document in the portal will have a label
Communicating w/Patients & Families
Portal Users Component

- You can use the Patient Portal Users component in PCC EHR to quickly review portal information and help get all of your families using the patient portal.
- The component allows you to manage portal users and can confirm whether portal balances are enabled & privacy is enabled.
### Portal Users Component

<table>
<thead>
<tr>
<th>Patient Portal Users</th>
<th>Manage Portal User</th>
<th>Name: Wilma Flintstone</th>
<th>Last Login: 07/11/18 11:30am</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Email: <a href="mailto:wilma@bedrock.com">wilma@bedrock.com</a></td>
<td>Unread Messages: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Phone: 800-722-1082</td>
<td>Unviewed Documents: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Balances: Personal balances not displayed</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Manage Portal User</th>
<th>Name: Fred Flintstone</th>
<th>Last Login: never</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Email: <a href="mailto:fred@bedrock.com">fred@bedrock.com</a></td>
<td>Temporary Password: WSyeHRcv</td>
</tr>
<tr>
<td></td>
<td>Phone: 800-722-1082</td>
<td>Unread Messages: 0</td>
</tr>
<tr>
<td></td>
<td>Balances: Fred Flintstone (Account # 1980)</td>
<td>Unviewed Documents: 0</td>
</tr>
</tbody>
</table>

**Add Portal User**

Review portal users who can view this patient, along with their recent activity.
Portal Users Component

Patient Portal Users
This patient has no associated portal users.

Add Portal User

Add Portal User

*Email Address: wilma@bedrock.com
*First Name: Wilma
*Last Name: Flintstone
Phone Number: 800-722-1082

*required

Sign In details will be automatically sent to the Portal User’s email address.
Portal Users Component

Open the Patient Portal Manager to reset a password, adjust patient access, and more.

Manage Portal User

Name: Fred Flintstone
Email: fred@bedrock.com
Phone: 800-722-1082
Balances: Fred Flintstone (Account # 1980)

Manage Portal User: Fred Flintstone

Edit Portal User  Delete Portal User
Portal User Name: Fred Flintstone
Email Address: fred@bedrock.com
Phone Number: 800-722-1082
Temporary Password: WSyeHRcv  Print Password  Reset Password

Patients connected to this portal user

<table>
<thead>
<tr>
<th>Name</th>
<th>Hide at age 18</th>
<th>DOB</th>
<th>Age</th>
<th>PCC #</th>
<th>Custodian</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dino Flintstone</td>
<td>Yes</td>
<td>04/24/14</td>
<td>4y 2m</td>
<td>3335</td>
<td>Wilma Flintstone</td>
</tr>
</tbody>
</table>

Select billing account for personal balance display

The balance will not include charges for patients in *italics*. These patients have privacy enabled or are not connected to the portal user.

- Fred Flintstone
- Patients: Dino Flintstone, Pebbles Flintstone
- Do not display balance
Portal Users Component

Portal Users

Manage Portal User

Name: Terry Manning
Email: tmanning@kobolds.net
Phone: 
Balances: Kevin M Manning (Account # 56)

Age-based privacy is enabled. Patient information cannot be viewed by this portal user.

Last Login: 07/19/18 11:36am
Unread Messages: 0
Unviewed Documents: 0

Manage Portal User

Name: Wilma Flintstone
Email: wilma@bedrock.com
Phone: 800-722-1082

Balances: Personal balances not displayed

Last Login: 07/11/18 11:30am
Unread Messages: 0
Unviewed Documents: 0

Wilma Flintstone does not see personal balances in the portal for this patient. If she should, you can click "Manage Portal User" to adjust.
Subject: Tips for Getting Started with Diabetes Management?

Date: 05/02/19 1:39pm
From: Ansel Addington
Phone: 802-846-8177

Hi Dr.,
Abigail's grandmother (who watches Abb after school) wanted to learn what she should know about her diagnosis. Anything useful to share?
-Ansel

Reply

Hello,
Our care coordinator can talk with Abigail's grandmother, either over the phone or you can schedule time to talk in person.

I've attached the handout that we provided at our last appointment.

Call the office (800-722-1082) or send a message for our scheduler, and we can set up an appointment.

-Nurse Mark
Attach Documents to Portal Messages
Attach Documents to Portal Messages
Attach Documents to Portal Messages

My Kid’s Chart

Abigail Addington
Sex: Female
Birthdate: 05/03/09
Last Physical: 12/07/18

Subject: Tips for Getting Started with Diabetes Management?

Thu 05/02/19 2:00pm
Mark Williams, M.D.

Hello,
Our care coordinator can talk with Abigail's grandmother, either over the phone or you can schedule time to talk in person.

I've attached the handout that we provided at our last appointment.

Call the office (800-722-1062) or send a message for our scheduler, and we can set up an appointment.

-Nurse Mark

Attachments

05/02/19 - Type 2 Diabetes Tips

Thu 05/02/19 1:39pm
Ansel Addington

Hi Dr.,
Abigail's grandmother (who watches Abb after school) wanted to learn what she should know about her diagnosis. Anything useful to share?

-Ansel

PCC
Pediatric EHR Solutions
Add Portal Message Button
Documents From Parents/Patients in Patient Portal

- Parents/Patients can attach PDF or JPG files to patient portal messages
- These documents will appear attached to the portal message in Messaging screen
Parent/Patient Attaches Document
Document Visible in Messaging Queue

06/13/17 10:56am Flintstone, Pebbles
Portal Message - Rash
Portal Message
Working with the Patient Chart
Outstanding Tasks

- The Outstanding Tasks component in the Medical Summary shows all outstanding tasks for the patient.
- Icons indicate if the task is attached to an order, phone note or document.
- You can add this component to other sections of the chart or protocols.
Outstanding Tasks Component

Icons indicate whether tasks are associated with orders, documents or messages. Click on an icon to go directly to the task.
Outstanding Tasks Component

- Orange chart sections and components help you quickly find outstanding tasks in the patient’s chart.
- Click on an icon to go directly to the task.
- Hover your mouse over each icon to get details about the task(s) associated with a visit.
Due Dates for Tasks

● You can add a due date to a task and then use PCC EHR’s tools to track down work that needs to be done today or later.

● When you create a task, the default due date will be today. You can change it at any time, and edit orders to update their due dates.
Due Dates for Tasks

I want my staff to call the family on 03/01/2019 to schedule their followup.
Due Dates for Tasks

By default, the Visit Tasks queue will only list tasks that are due or past due.

You can filter the queue. I'm viewing all Referral Orders that are due on or before 01/17/19.
Due Dates for Tasks

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Date</th>
<th>Due</th>
<th>Provider</th>
<th>Order/Subject</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>01/17/19</td>
<td>03/01/19</td>
<td>James Davidson, Jr. M.D.</td>
<td>Followup - Call to Schedule</td>
<td>Appointment Needed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Followup</td>
<td>Confirm Outcome</td>
</tr>
<tr>
<td></td>
<td></td>
<td>01/30/19</td>
<td></td>
<td>Referral - Speech Therapy</td>
<td></td>
</tr>
</tbody>
</table>

The Outstanding Tasks component displays the due dates for tasks in incomplete orders.
Hiding Orders from Patient Reports

● When configuring orders in the EHR it is possible to hide items from patient reports (patient vis. summary, health info. summary & patient portal).
  ○ Example: sensitive labs

● When the order is placed, there’s an option to hide for that patient specifically

● Changing the default under the configuration automatically hides that order for every patient
Hiding Orders from Patient Reports

Screening Orders - Add Order

Order Name: Depression Screen

- *Include on Patient Reports* will be selected when this order is issued
- Allow this order to be Refused
- Allow this order to be Contraindicated

Lab Configuration

<table>
<thead>
<tr>
<th>Lab Orders</th>
<th>Common Tests</th>
<th>Lab Facilities</th>
</tr>
</thead>
</table>

Edit Lab Order

Lab Order Name: GC/Chlamydia

Default Lab Facility: select a lab facility

- Enable recording of Specimen Collection user, date and time
- *Include on Patient Reports* will be selected when this order is issued
- Allow this order to be Refused
- Allow this order to be Contraindicated

*Uncheck this box*
Hiding Diagnoses & Family Medical History from Patient Reports

- Diagnoses (both from the problem list and visit note) can be hidden from patient reports
- Diagnoses and family medical history SNOMED codes can be hidden from patient reports by default in Diagnosis Configuration
# Hide Problem List Diagnoses

## Problem List

*Unsaved Changes*

<table>
<thead>
<tr>
<th>Status</th>
<th>Problem</th>
<th>Problem Note</th>
<th>Onset</th>
<th>Resolved</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Asthma</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Eczema</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Pregnancy test positive</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Display:** All Statuses

**Pediatric EHR Solutions**
Hide Family Medical History Diagnoses

[Image of a Family Medical History form with an entry for Acute type B viral hepatitis]
Hide Visit Diagnoses

Disorder of respiratory system
Refine the diagnosis of Disorder of respiratory system
ICD-10: J98.9 Respiratory disorder, unspecified

Include on Patient Reports

notes

Add to Problem List Onset: mm/dd/yy Problem Note: problem note

Pregnancy test positive
Refine the diagnosis of Pregnancy test positive
ICD-10: Z32.01 Encounter for pregnancy test, result positive

Include on Patient Reports

notes

ACTIVE ON PROBLEM LIST: Pregnancy test positive
Diagnosis Configuration

**Edit Diagnosis**

- **Description:** Pregnancy test positive
- **Include on Patient Reports:**
  - Apply historically throughout all patient charts
  - Favorite - available for selection in the Diagnoses and Problem List components
  - Allergy - available for selection in the Allergies component
  - Family Hx - available for selection in the Family Medical History component

**Buttons:**
- Cancel
- Save
Access Problem List Diagnosis in Visit

● The diagnosis component in the visit will access the problems on the problem list for selection when diagnosing the patient in the visit.
Fenton Preterm Growth Charts

- PCC EHR includes the Fenton preterm growth charts
- Enter the gestational age at birth in the patient’s demographics
- If gestational age < 37 wks, Fenton charts will display until the patient reaches 50 weeks of gestational age.
Fenton Preterm Growth Charts
Down Syndrome Growth Chart

- If a diagnosis of Down Syndrome is added to the patient’s problem list, the Down Syndrome growth chart will appear automatically.
Down Syndrome Growth Chart
Using PocketPCC for Charting
Enter Vitals in Pocket PCC

**Vitals**

- **Weight**: 88 lbs 1 oz (39.94 kg) 81st percentile (CDC)
- **Height**: 57 in (144.78 cm) 82nd percentile (CDC)
- **Temperature**: 98 °F Oral
- **BMI (Estimated)**
  - 19.1 kg/m²
  - Healthy Weight

**Visit: 07/05/18**

- **Sick - Bright Futures**
  - **Appointment Details**
  - **Intake**
  - **History**
  - **Review of Systems**
  - **Social/Family History**
  - **Physical Exam**
  - **Diagnoses**
  - **Lab**
  - **Medical Test**
  - **Medical Procedures**
  - **Immunizations**
  - **Plan**
  - **Forms**
  - **Prescriptions**
  - **Visit Documents**
  - **Amendment Requests**

- **Vitals**
  - **Weight**: 88 lbs 1 oz 81st percentile (CDC) (39.94 kg)
  - **Height**: 57 in 83rd percentile (CDC) (144.78 cm)
  - **Temperature**: 98 °F Oral
  - **BMI**: 19.1 kg/m² 78th percentile (CDC) Healthy Weight

*Hover over vitals to see who entered them*
Attach Photos to Charts via Pocket PCC
Attach Photos to Charts via Pocket PCC

You can take or upload multiple files at one time, up to 30mb.

Edit tags before saving.

PCC Pediatric EHR Solutions
Attach Photos to Charts via Pocket PCC
Sending Records Electronically
Attach Document to Direct Secure Msg

Summary of Care Record

Continuity of Care Document

Patient: Megan Marcone
Date of Birth: May 20, 2010
Sex: Female
Race:
Ethnicity:
Contact Info: Home: 766 Terry Drive, Winston, VT 05069, US Tel: 802-555-0199
Patient Email: 32989.2.16.84.1.1.193.3.3402.400.100-3
Document Id: 79049732-0bcb-4bf9-498-e0bca32614292
Document Created: May 3, 2019, 13:07:45-6403
Performer (primary care provider): PCC EHR
Author: PCC EHR

Select a referral or outbound transition of care:
- Select referral or outbound transition of care

- Print
- Save as a PDF file
- Save as a C-CDA file
- Send via Direct Secure Messaging

After selecting “Send via Direct Secure Messaging”, the “Print” button changes to a “Send to...” button.

PCC Pediatric EHR Solutions
Attach Document to Direct Secure Msg

Fill out the To and Subject fields, optionally add a message, and use the buttons at the bottom of the dialogue to add files or documents.

Select a document from the Recent Documents list or a document category, and click “Attach.”
Attach Document to Direct Secure Msg

The document appears under the list of attachments, with its title and file size.

Click "Attach File" to attach a file from your workstation or laptop.
Immunizations & Inventory
Track Imms Admin with Barcodes

Once you’ve placed your immunization orders, click “Select Vaccine Lots”
Track Imms Admin with Barcodes

Select eligibility status, and then scan your vials.

The scanner will automatically select the lot. You can also use the drop-down arrows, before or after scanning, to manually select a lot or open the Lot Manager.

PCC Pediatric EHR Solutions
View Imms Admin in the Lot Manager

When you select a lot . . .
View Imms Admin in the Lot Manager

... you see a log of all transactions associated with that lot

<table>
<thead>
<tr>
<th>Adjustment Date/Time</th>
<th>Adjustment Reason</th>
<th>Adjuster Note</th>
<th>Adjuster</th>
<th>Patient Name</th>
<th>Patient DOB</th>
<th>Patient Sex</th>
<th>Adjust Increase Amount</th>
<th>Adjust Decrease Amount</th>
<th>Balance of Doses</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/16/2018 2:28pm</td>
<td>Increase - Shipment Received</td>
<td>Mark Williams, M.D.</td>
<td>100</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09/20/2018 1:00pm</td>
<td>Decrease - Wasted</td>
<td>Douglas Beasley</td>
<td>2</td>
<td>98</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/04/2018 11:56am</td>
<td>Decrease - Administered</td>
<td>Deschutes, Brooklyn Evalee</td>
<td>3430</td>
<td>04/21/2014</td>
<td>F</td>
<td>1</td>
<td>97</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/09/2018 11:57am</td>
<td>Decrease - Administered</td>
<td>Manero, Jordan</td>
<td>3074</td>
<td>10/10/2015</td>
<td>M</td>
<td>1</td>
<td>96</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/11/2018 11:57am</td>
<td>Decrease - Administered</td>
<td>Flintstone, Peabody</td>
<td>3336</td>
<td>09/09/2008</td>
<td>F</td>
<td>1</td>
<td>95</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Vaccine-Preventable Diseases

- The Immunization History & immunization order component will list vaccine-preventable diseases.
- The disease is added to the immunization section if diagnosed in a visit or added to problem list.
# Vaccine-Preventable Diseases

<table>
<thead>
<tr>
<th>Disease</th>
<th>Date</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Varicella</td>
<td>03/29/12</td>
<td></td>
</tr>
<tr>
<td>DTaP/HIB</td>
<td>06/28/12</td>
<td></td>
</tr>
<tr>
<td>HepB/HIB</td>
<td>05/26/11</td>
<td>10/25/11</td>
</tr>
<tr>
<td>Prevnar 7</td>
<td>06/28/12</td>
<td>09/25/12</td>
</tr>
<tr>
<td>Ordered</td>
<td>09/25/12</td>
<td></td>
</tr>
<tr>
<td>Varicella</td>
<td>06/17/16</td>
<td>date unknown</td>
</tr>
</tbody>
</table>
EHR Navigation
Open Multiple Windows in PCC EHR

Use these icons to jump directly to PCC EHR, the Appointment Book, the Import Documents window, or the Practice Management window.
Open Multiple Windows in PCC EHR

The “Window” drop-down shows you only the windows that are currently open.
Organize Assigned User Drop Down List

- Under Tools>User Administration there is a User Selection List option
- Using this tool you can organize the Assigned User drop down lists on the visit task & messaging queues. Also impacts Appt Book provider arrangement.
- This organization will not reflect when picking a user inside a visit
Organize Assigned User Drop Down List
Configure Visit Statuses

- The Visit Status Configuration tool can be used to:
  - Add new visit statuses
  - Change the color of visit statuses
  - Set which statuses are part of the click rotation on the schedule screen
Visit Status Configuration Tool
Add New Visit Status
### Visit Status Options on Schedule Screen

<table>
<thead>
<tr>
<th>Visit Status</th>
<th>Room</th>
<th>Tasks</th>
<th>Arrival</th>
<th>Time</th>
<th>Last</th>
<th>First</th>
<th>DOB/Sex</th>
<th>Age</th>
<th>Visit Reason</th>
<th>Provider</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready-Prov</td>
<td>-</td>
<td>END VISIT</td>
<td>11:36am</td>
<td>8:30am</td>
<td>Hamann</td>
<td>Train Adam</td>
<td>03/05/12 M</td>
<td>5y 3m</td>
<td>Sick Call</td>
<td>Gomez</td>
</tr>
<tr>
<td>Arrived</td>
<td>-</td>
<td>END VISIT</td>
<td>11:36am</td>
<td>10:15am</td>
<td>Hamann</td>
<td>Brittany</td>
<td>03/26/06 F</td>
<td>11y 2m</td>
<td>Sick Call</td>
<td>Casey</td>
</tr>
</tbody>
</table>

**Other Visit Status Options:**
- w/Nurse
- Ready-Prov
- w/Provider
- Ready-Nurse
- Breastfeeding
- Bathroom
- RM

**PCC Pediatric EHR Solutions**

**THRRIVING THROUGH CHANGE**
Choose Visit Status Counters in My Account
Visit Status Counters in the EHR
Patient Forms & Summaries
Generate Form Letters in PCC EHR

- You can add the new Forms component to PCC EHR as a way to print, save, and/or upload forms to the Patient Portal.
- Forms can be configured to be pre-populated with demographic data (and some clinical data)
- Forms can prompt you to enter additional info, rather than entering handwritten data on forms.
Generate Form Letters in PCC EHR
Generate Form Letters in PCC EHR
Generate Immunization Forms in PCC EHR

<table>
<thead>
<tr>
<th>Vaccine</th>
<th>02/11/08</th>
<th>04/19/08</th>
<th>05/19/08</th>
<th>05/11/09</th>
<th>11/12/12</th>
</tr>
</thead>
<tbody>
<tr>
<td>DTaP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tdap</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hepatitis A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hepatitis B</td>
<td>12/16/07</td>
<td>02/11/08</td>
<td>04/19/08</td>
<td>05/19/08</td>
<td></td>
</tr>
<tr>
<td>Hib Unispec</td>
<td>02/11/08</td>
<td>04/19/08</td>
<td>05/19/08</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HPV</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Influenza</td>
<td>11/14/10</td>
<td>09/17/16</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPV</td>
<td>02/11/08</td>
<td>04/19/08</td>
<td>05/11/09</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menactra MCV4P</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MMR</td>
<td>02/09/09</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MMRV</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>12/08/10</td>
</tr>
</tbody>
</table>

PCC Pediatric EHR Solutions
Configure Patient Visit Summary

- Tools> Patient Visit Summary Configuration allows your practice to configure the data that shows on the printed visit summary.
- It’s possible to add note components from the visit (e.g. Plan), so that the notes print on the visit summary.
- For those using the patient portal, there’s a Patient Portal Configuration Tool that allows you to show plan notes on the portal.
Configure Patient Visit Summary

Configure problem notes
- Display problem notes with problems.

Include checked items on the standard Patient Visit Summary
- Demographics
  - Patient Name, DOB, Sex, and PCC#
  - Patient Race, Ethnicity, and Preferred Language
  - Future Appointments and Date of Last Physical
- Visit Information
  - Allergies
  - Chief Complaint (not configured)
    - select chief complaint component
  - Clinical Instructions
    - Plan - Generic Note
  - Diagnoses
  - Immunizations
  - Labs
  - Medications
  - Orders

Cancel | Save
Configure Patient Visit Summary

Visit Summary for 06/17/16

Mark Williams, M.D.
PCC Pediatrics Main Office
Sick - Pirate Peds

Plan
Supportive Care
   Lots of fluids, change toothbrush, Tylenol for pain
Staying Up-to-Date on Features
Designate a “Super Trainer”

- PCC EHR is constantly changing as we add new, exciting features. We hold weblabs for the new releases before the update to show the new features and answer any questions.
- Designating a person (or a few people) who can attend the weblabs for each release and then disseminate that information to your office will help you take advantage of all the new functionality in PCC EHR.
Online Documentation

- PCC EHR online documentation is available 24/7 at: learn.pcc.com
- Stay on top of release documentation by joining PCC Community or scheduling a regular call with your Client Advocate.
Wrap Up & Questions